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Welcome to ABB Automation Builder 2.2.1

These release notes contain important information about the Automation Builder software.

Please read this file carefully and completely. It contains the latest information and relevant documentation.
The latest version of this document is available at:
http://dg8avafk7mhsg.cloudfront.net/AB_ReleaseNotes/Automation_Builder_2.2/ReadMe.pdf

Most important changes since Automation Builder 2.2.0

Automation Builder
e Troubleshooting is eased by an integrated Automation Builder functionality to collect all available data and zip it for
exchange with support line

PLC - AC500 V3 Processor Modules (PM5xyz)

Much faster access to RETAIN/PERSISTENT and addressed (%M area) variables

Additional PLC shell commands for ethernet extended diagnosis

CAN: Support of CM598-CN, limited to protocols CAN 2A and CAN 2B

Modbus TCP: Significant less PLC load from Modbus TCP client and new client POU EthModMast2 with connection
parameters for each connection.

o Ethernet: New POU DNS resolve in Ethernet library

o KNX: Usability and stability improvements

Modbus TCP — Communication Interface Modules (CI52x-MODTCP)
o Firmware update functionality of Modbus TCP devices (CI52x) is now available via IP configuration tool, which can be
installed via Additional Tools within the Automation Builder installer.

Drive composer pro
o New Drive composer pro version 2.3.1 integrated in Automation Builder 2.2.1

Panel Builder
o Panel Builder software is included into the Automation Builder version profiles, starting with Automaton Builder 2.1. When
installing Automation Builder 2.2 including version profile 2.1 it will install Panel Builder 2.8 and 2.6 and automatically use
the right version when launching from an Automation Builder project.

General information

Standard and Premium license of Automation Builder 1.x will not be valid for Automation Builder 2.x For

Automation Builder 2.x standard and premium features appropriate licenses need to be purchased and activated.

Please check the upgrade licenses possibilities with your ABB sales representative. For details please refer to Automation

Builder lifecycle documentation in ABB Library or contact your sales representative.

¢ The installation of the ABB Automation Builder software requires administrator rights.

Prior to installation, the Automation Builder, Control Builder Plus, CODESYS software and the CODESYS Gateway Server

must be shut down.

e Automation Builder 2.2 installation completely replaces installed versions of Automation Builder prior to 2.2.0 / Control
Builder Plus. Side-by-side installation of Automation Builder and Control Builder Plus is not supported, but also not
required. Projects created with previous versions can be upgraded to the latest version easily. If upgrading is not desired,
projects can be opened in one of the integrated version profiles.

e Automation Builder 2.2 creates a new device repository. Devices which had been installed additionally in previous versions

of Automation Builder/Control Builder Plus can be migrated via menu “Tools” = “Migrate third party devices”.

The English documentation contains the latest changes for Automation Builder 2.2. Latest documentation packages can

be found on the ABB website: www.abb.com/plc = Download Documentation, and then select your language.

e Automation Builder 2.2 includes CODESYS version 3.5 and 2.3. Side-by-side installations of other CODESYS version 2.3

based engineering tools like AC1131 may cause issues or disturb the use of one or both tools. If side-by-side installation

cannot be avoided, please install all other tools BEFORE installing Automation Builder.

Windows Server 2012 installation: CoDeSys V2.3 Gateway Service Wrapper or server restart required after installation.

For concurrent Gateway access a specific configuration is required, please refer to Automation Builder help for details

When installing CP600 control panel option including previous version profiles, the Panel Builder installer asks for

replacing the last installed version of Panel Builder. This question has to be answered with “no”. In case of accidently

choosing “yes”, the installer has to be executed again, although it has been finished successfully.

o Please create project archives (File -> Project Archive -> Save/Send Archive...) to support smooth project upgrade to

latest Automation Builder version before installing latest version

After upgrading projects to latest Automation Builder, please check for having the matching firmware installed before doing

a download.

Availability of online activation of licenses might be affected by local IT security settings. In case the online activation of

licenses is failing please use the offline activation.


http://dg8gvgfk7mhsg.cloudfront.net/AB_ReleaseNotes/Automation_Builder_2.2/ReadMe.pdf
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System Requirements

o 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor
e 4GB RAM
o 5-18 GB free available hard disk space depending on the selected feature set
e SVGA graphics adaptor 256 colors, resolution of 1024x768 pixels
e Supported operating systems:
- Windows 7 (32/64 Bit) Professional / Enterprise / Ultimate (SP1 required)
- Windows 10 (32/64 Bit) Professional / Enterprise
- Windows 8.1 (32/64 Bit) (requires .Net Framework version 4.6.2 installed prior to Automation Builder installation)
- Windows Server 2012 R2 64 bit (all devices have to be directly accessible by the server; requires enabled .Net
Framework 3.5, refer to section below for installation details)
Note: Windows XP and Windows VISTA are no longer supported.
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Changes in Automation Builder 2.2.1

The release includes the following device groups:

Automation Builder

Functional changes / New features Version

Licensing: 2.2.0

. License selection (local or from server) can be configured via Automation Builder (Tools -> Options ->
Startup settings). By default, any available license is taken.

. Licenses purchased 2019 or alter allow more than 4 licenses to be activated in one license container

Modularized Automation Builder installation structure reduces the download size and the installation time in case no 2.2.0
or only few compatibly versions are selected during installation
Virtual System Testing: 2.2.0

e  Virtual Drive ACS880 is now supported (available as standalone software).
Please contact Global Drives Support (global.drivessupport@fi.abb.com or +358 50 33 27200) for further
information.

. The technology previews of virtual Drives ACS380 and ACS580 are discontinued due to availability of
Virtual Drive ACS880 support.

Automatic update of release notes in Automation Builder setup and tool with latest available version from internet 2.2.0
Integration of 3S Automation Platform SP13 Patch 1 2.2.0
Troubleshooting is eased by an integrated Automation Builder functionality to collect all available data and zip it for 291
exchange with support line o
Fixed issues ID
Improved Automation Builder installer robustness AB-12497
Script objects are lost after project update AB-15100
PLC runtime licensing: "Return license" does not work for licenses installed via SD Card
Return license works properly when Automation Builder is connected to the PLC AB-14019
Known problems ID
Licensing: Number of standard or premium licenses that are purchased 2018 and earlier that can be activated in one n.a.

license container is limited to 4
Workaround: use license dongle if more licenses are required or contact Automation Builder support to update the
licenses (refer to new features)

Installation issue on Windows 10:
During installation there might be issues with automatically deleted files by Windows in temporary folders which are AB-15979
required for installation. This automatic temporary file deletion is introduced with Windows 10 feature update (build
17720 and later).

W orkaround: if you run into installation issues on Windows 10 please try to disable "Storage Sense™:
Windows -> Open Settings -> Click on System -> Click on Storage -> Turn off the Storage sense toggle switch

During uninstall all of Automation Builder the Virtual Drives uninstallation might fail n.a.
W orkaround: Please uninstall Virtual Drives via Windows Control Panel -> Programs and Features

GSDML: The character "/" used inside a module name of a GSDML file is not supported by Automation Builder. An

error message is shown during installation to Device Repository. AB-13924
W orkaround: Remove corresponding characters in module name of GSDML file.

Projects created in Control Builder Plus software versions cannot be upgraded automatically to Automation Builder n.a.
version 2.1.X.

W orkaround:

e open project with profile "Automation Builder 1.2", perform upgrade, save project
e open project with latest profile "Automation Builder 2.0", perform upgrade, use project

ABB 1/0O mapping list view for disconnected modules on PROFINET 10 devices with Shared Device functionality like 2.0.3
AC500 CM589-PNIO-4 (-XC) or 3" party PROFINET IO devices (drives, /0 modules, encoders, etc.) is temporarily
not supported. As aresult, no /O mapping information is shown for disconnected modules on CM589-PNIO-4 (-XC)
or 3" party PROFINET 10 devices with Shared Device functionality in Automation Builder.
Workaround:
e use standard I/O Mapping for disconnected modules on CM589-PNIO-4 (-XC) or 3 party PROFINET IO devices
with Shared Device functionality

Automation Builder installation: n.a.
In case a PC reboot is required/executed during Automation Builder installation the setup might have to be restarted
manually after PC restart.

Workaround: Please start the setup after restart and select the desired options to install. The setup will then continue
the installation where it has been interrupted for reboot
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Disclaimer: Technology Previews are designed to give you a sneak peek at upcoming technologies. They are non-final versions of
our product and should NOT be taken as a measure of the fit, finish, capability, and overall quality of the final release (including user
documentation). Technology Preview features can be removed without further notice. If you use the preview, you could experience
things that go wrong, data that gets lost, and things to change. While we don't stop you using these versions in projects, we don't
recommend it if you cannot afford data loss and the usual quirks of running preview software. It will not be possible to call ABB
Support hotlines for help with Technology Preview features. If you are interested in getting support for a Technology Preview feature
this can be done in the context of a piloting. In this case please contact us to set up a piloting agreement.

PLC - AC500 V2 Processor Modules (PM5xy)

Functional changes / New features

Version

Ethernet:
MQTT: support loT communication protocol MQTT (IEC and C-Code library)

2.8.0

1/0-Bus:
I/0-Bus: HotSwap functionality for PM585-ETH, PM59x-ETH, PM595-4ETH
Note: Hotswap functionality cannot be used together with S500-S Safety IO modules

2.8.0

Virtual AC500 V2 supports now also definitions of % HW addresses

2.8.0

Fixed issues

ID

CANopen/CAN configuration of CM598-CN:
Configuration error when parameter "Heartbeat producer time" (ID: 0x01017000) does not exists

CPUFW-6088

ACS500 configuration of shared device functionality with a TR-Electronic encoder doesn’t work in Automation Builder
212

AB-15086

Known problems

ID

Web Visualization: Java Applet might be blocked by your web browser

The Java Applet that provides the AC500 web visualization, created in Automation Builder V2.0.4 or lower includes
an intermediate certificate that expired on Saturday April 13th 2019. After this date the validation procedure for the
certificate might fail as it cannot be validated via the “OCSD” procedure.

Depending on your browser and whether your computer is connected to the Internet, the Applet will be blocked after
that date.

Workaround: The workaround steps are described in detalil in the following application note:
http://search.abb.com/library/Download.aspx?DocumentiD=3ADR010388&L anguageCode=en&DocumentPartld=&A
ction=Launch

AB-16179

Online access: Additional Visu Files at PLC without Onboard Ethernet leads to error during download
Workaround: Don't use Additional Visu files in PLCs without Onboard Ethernet

CPUFW-6929

C-Code: PLC crashes on download program running C-Code-lib build with newer revision of FWAPI, e.g. Bacnet
library created with AB 2.2.0 (FWAPI 2.8.x) used with PLC firmware V2.7.2.
Workaround: Update PLC firmware to same version as FWAPI in C-code lib, e.g. PLC firmware V2.8.1

CPUFW-6916

Online access: Connecting a CP600 Panel via CODESYS protocol serial avoid creating a boot project
W orkaround: Disconnect panel during creating of boot project

CPUFW-6885

Working on Codesys 2.3 projects with administrator and non-administrator users might lead to inconsistent data
W orkaround: avoid working in this setup with administrator and non-administrator users

n.a.

Activating the CANopen sync mode requires to activate the "generic configuration view" (see "Tools->Options-
>Device editor")

AB-9768

EtherCAT: Usage of the SyncUnits feature with enabled AutoConfiguration for AC500 V2/V3 EtherCAT might result
in compilation errors as some ENI file data gets not correctly generated.

Workaround: in case you are running into such errors please contact Automation Builder support team

AB-15520

Using GSDML files with sub-modules for PROFINET Shared Device is not working. AC500 PLC stops with wrong
configuration data.
Workaround: not available

AB-13836

CM574-RS: If the parameter "Enable debug" is set to "Off" and when the PLC stops the CM574-RS continues to run
causing an E2 failure.

W orkaround:

Set the parameter "Enable debug" to "On".

CPUFW-5538

When PM5xx-ETH with 4 x CM597-ETH connected on the switch, the IP-Configuration tool show a wrong
"Configured IP Address" for PM5xx-ETH. When unplugging the cable from all CM597-ETH, the "Configured IP
address" shows the right value.”

Workaround:

Unplug the CM597-ETH from the switch to check the IP address from PM5xx-ETH.

CPUFW-5537

System: DC541: Error message after firmware update also in case of correct update
W orkaround:

CPUFW-4659



http://search.abb.com/library/Download.aspx?DocumentID=3ADR010388&LanguageCode=en&DocumentPartId=&Action=Launch%20
http://search.abb.com/library/Download.aspx?DocumentID=3ADR010388&LanguageCode=en&DocumentPartId=&Action=Launch%20
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Check FW version of DC541 after update
System: DWORD_TO_LREAL and UDINT_TO_LREAL: DWORD/UDINT value cannot be proper converted to
LREAL if DWORD/UDINT >16#80000000. For PM595-4ETH CODESYS compiler generates warning.
Workaround:
Add new function:
FUNCTION DWORD_TO_LREAL_NEW : LREAL
VAR_INPUT x: DWORD; END_VAR
VAR b: LREAL; END_VAR
b := DWORD_TO_LREAL(x); CPUFW-3741
IF b < 0.0 THEN b := 4294967296.0 + b; END_IF;
DWORD_TO_LREAL_ABB :=b;
call function DWORD_TO_LREAL_NEW instead of DWORD_TO_LREAL in user program:
PROGRAM PLC_PRG
VAR a: DWORD; b: LREAL; END_VAR
b := DWORD_TO_LREAL_ABB(a);
POU: PM595-4ETH, LED_SET is without function in Mode=0. The POU is intended to control the additional LED's.
W orkaround: CPUFW-3721
Use POU LED_SET to control the additional LED's.
System: Firmware download to CM574-RS can lead to watchdog error of CM574-RS in case of using freewheeling
task in CM574-RS
Workaround: CPUFW-3675
Don't use freewheeling task in CM574-RS
Some Online Services lead to log out on PM595-4ETH
W orkaround: CPUFW-3465
None
Socket opened by IEC application via SysLibSock is not closed on PLC Reset
W orkaround: CPUFW-3443
None
"Run time of FB DEL_APPL is increased for about 6s. This is caused by increasing the time for delete flash."
W orkaround: CPUFW-3087
None
SysLibFile library: As of V2.3.x, dtLastAccess.time is always 00:00 on call of SysFileGetTime()
W orkaround: CPUFW-2833
None
CS31-Bus: In case of connection of AC31 modules like 07AC91, 07Al191, DC91 to CS31-Bus of COM1 and/or COM2
of CM574-RS, PM5xx-eCo, PM57x or PM58x a lot of bus errors occurs. Sometime this modules disconnects and
reconnects. S500 modules don't show such effects. CPUFW-1833
W orkaround:
Don't use this datatypes in webvisu
WEB server: ActiveX-Element display incorrectly
W orkaround: CPUFW-1593
Don't use Active-X element in webvisu
WEB server: Alarm tables do not work on webvisu, if "All alarm groups" is selected. Messages are not displayed
properly.
Workaround: CPUFW-1506
Don't select "All alarm groups"
Telecontrol: (IEC60870-5-104) connection does not function properly after a long cable break
W orkaround: CPUFW-1433
Restart PLC after long cable break
WEB server: In WMF-file integrated text isn't displayed in visualization
W orkaround: CPUFW-1310
Don't use WMF-file with integrated text
WEB server: The following datatypes are wrongly displayed in the webbrowser with the mentioned formatting strings:
byte with %i and %u, in both cases only the format letter (i or u) is displayed without the %
sint with %s shows the two's complement when negative values should be displayed
udint with %d shows a -1 if the maximum possible value of this datatype should be displayed
udint with %i and %u, in both cases only the format letter (i or u) is displayed without the %
dint with %i,only the format letter (i) is displayed without the %
Ireal with %2.9f shows the infinity sign if the maximum/minimum value of this datatype should be displayed CPUFW-1304
udint with %s shows a -1 if the maximum possible value of this datatype should be displayed
real and Ireal with %s shows 0.0 if the minimum possible value of this datatype should be displayed
Ireal with %s shows the word infinity if the maximum possible value of this datatype should be displayed
char with %c, only the format letter (c) is displayed without the % instead of a single letter
W orkaround:
Don't use this datatypes in webvisu
Online: Display of the task priority shown not the correct value for interrupt task -> It is not the shown value of the CPUFW-1072
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boot project!
W orkaround:
No workaround. Interrupt task: Shown priority is the internal operating system priority
WEB server: option "Best fit in online mode" doesn't work properly
W orkaround: CPUFW-921
WEB server: Option "Best fit in only mode" is not recommended for web visualization.
SD card write protection function is not available for AC500-eCo CPUs
W orkaround: CPUFW-748
SD-card write protection is not evaluated by AC500 CPUs. Write protected cards can be overwritten. Protect the SD ECOHW-11
card by yourself.

PLC - AC500 V3 Processor Modules (PM5xyz)

Important Notes:

- For AC500 V3 CPUs, the diagnostic handling is different from the AC500 V2 CPUs.
Functional changes / New features Version

System 3.2.2
Much faster access to RETAIN/PERSISTENT and addressed (%M area) variables
Ethernet extended diagnosis 3.2.2
Additional PLC shell commands:
ethernet desc - get the current ethernet interface settings
ethernet netstat - get list of used sockets "
Ethernet 3.2.2
New POU DNS resolve in Ethernet library
Modbus TCP 3.2.2
Significant less PLC load from Modbus TCP client.
Modbus TCP 3.2.2
New client POU EthModMast2 with connection parameters for each connection.
CAN 3.2.2
Support of CM598-CN, limited to protocols CAN 2A and CAN 2B
KNX 3.2.2
Usability and stability improvements
OPC UA server enhancements 3.2.0
- User management
- Definition of (client specific) symbol configurations
- Alarms and conditions (Events part)
Protocol IEC61850 (MMS server, GOOSE) 3.2.0
Updated library 4.0.4.0 release with TUV certificate
KNX 3.2.0
Add KNX button and LED setting via AC500 Display
SD-Card 3.2.0
FW update with compatibility check (needs Update FW 3.2.0.x)
Display FW 4.1 with 3.2.0
- rework configuration menu <CFG>
- rework display value menu <VAL>
- add diagnosis menu <DIAG>
- add KNX button, LED
1/0-Bus 3.2.0
Local I/0O HotSwap functionality added
Buffered data, PlcShell commands for RETAIN/PERSISTENT: 3.2.0
- getsramlayout - Display layout of complete RETAIN/PERSISTENT.
- clearsram - Init and mark SRAM segment or complete RETAIN/PERSISTENT as free.
- savesram - save complete RETAIN/PERSISTENT content to file.
- Restore complete RETAIN/PERSISTENT content from file
Ethernet interface 3.2.0
Independant Gateway configuration for ETH1/ETH2 Ethernet interfaces
MQTT 3.2.0
Implementation of IoT communication protocol MQTT
New Diagnosis concept and system (1st step) 3.2.0
- CPU errors Battery, Flashdisk
- [/0-Bus and S500 errors
- auto control of ERR LED
PROFINET 3.2.0
Introduction of new driver for CM579-PNIO (with limited diagnosis capabilities)
EtherCAT 3.2.0
Enhanced commissioning diagnosis — Manual control of bus states via Automation Builder
System 3.2.0
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Integration of CODESYScontrol V3.5 SP13 PO
Technology Preview: C-Code support for AC500 V3 PLCs is just enabled for PM5650 3.2.0
Protocol KNX - licensed per PLC — PS5604-KNX runtime license 3.1.4/3.2.0
Fixed issues ID
UpdateFW: PLC with SystemFW 3.2.2.58 and UpdateFW 3.2.0.188 -update of only UpdateFW to version 3.2.1.43 CPUFW-6972
cause stay of PLC in state "update".
MQTT: Mqtt POUs with file need full path instead of relative path CPUFW-6768
KNX: If the CPU reboots or the application restarts, the first changed output value of the group addresses is CPUFW-6747
immediately sent to the KNX.
The last sent value of the first sent group address is not matching the value out of the PLC application (if value is not
equal to default/initial value) and is not sent again after the first calculation.
In this case the calculated value in the PLC differs to the last sent value on the KNX bus.
After calculation of the value, the changed value is not sent again to the KNX bus.
KNX: ABB_loDrvKNX_AC500.library - the following KNX DPT are transferred in Motorola byte order to IEC data type
ARRAY[] OF BYTE:
- Channel Group object name |EC data type DPT
- LIB-1716/
- 35 iTime ARRAYI0..2] OF BYTE 10.* CPU_FWLIB-90/
- 36 qTime ARRAYJ0..2] OF BYTE 10.* AB-14564/
- 45 iString ARRAY[0..13] OF BYTE 16.* loDrvKNX 3.5.13.7
- 46 qString ARRAY[0..13] OF BYTE 16.*
- 51 iDateTime ARRAYI0..7] OF BYTE 19.*
- 52 gDateTime ARRAYI[0..7] OF BYTE 19.*

loDrvKNX: some data types (Time, DateTime, String, Color) are transferred in IEC data type ARREY and in Motorola
byte order - Convert functions are available (except for “Color”) for the specific datatypes

CPU_FWLIB-90/
LIB-1716

KNX: ABB_loDrvKNX_AC500.library - the following KNX DPT are transferred in Motorola byte order to IEC data type
ARRAY[] OF BYTE:

- Channel Group object name IEC data type DPT
- 55 iColor ARRAYJ[0..2] OF BYTE 232.*
- 56 gColor ARRAYJ[0..2] OF BYTE 232.*

Fix: Color information is shown in the 10 mapping description within Automation Builder

CPU_FWLIB-204

Ethernet FTP server:
When PLC with configured FTP server is starting up from bootproject and power is lost at the right moment, it might

get into a state where it will no longer enter RUN ever again. In the PLC log there will be a message "chpasswd CPUFW-6600
failed" and the only remediation is a FW update (even to the same version)

Ethernet WEB server:

HTTPS is not supported for PLC FW 3.1.x in combination with Chrome Internet Browser version > V60. CPUFW-6286
Licensing: CPUFW-5961
The functionality Remote Target Visu and IEC61850 do not follow the standard demo licensing period. If used

without license the functionality stops after 30 minutes. In this case the PLC remains in status running but will stop

when the standard demo period is expired.

SD-Card: CPUFW-5917
Update with write protected sdcard results in an endless loop for the update process.

IEC 61850: CPUFW-5902
GOOSE subscribe does not work

Ethernet: CPUFW-5896
The PLC doesn't apply the changes in IP tool ("Configured IP Address") and Display before re-boot.

Ethernet: CPUFW-5884
Sometimes Online access with 3S block driver Tcplp cannot be established.

System: CPUFW-5881
SysTaskSuspend blocks for 50ms.

Network Variables (NV): CPUFW-5803
Does not work with default Broadcast address 255.255.255.255. AB2.2.0
CAA-File: CPUFW-5746
After creating and then deleting a big file which filled all available memory space on the disk (sdcard or userdisk), the

DISK_STATUS fb always shows that there is no space left. It is also impossible to perform other file/directory

actions, e.g.: creating a new directory.

System: CPUFW-5560

In case of time jumps might have undesired behavior in the system.
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There might be variable naming conflicts when using IEC60870 and AC500 V3 diagnosis with enabled PLC setting
'diagnosis for devices'. This issue is resolved by using a dedicated namespace for IEC60870. Corresponding
warnings are shown in the message window.

AB-15081

Known problems

FW 3.2.0:

Downgrade of AC500 PLCs from firmware 3.2.x version to previous versions via Automation Builder 2.1.X is not
supported.

W orkaround:

Please prepare SD-card with desired firmware versions and execute firmware version update via SD-card

n.a.

PM5630: There might be not sufficient memory for boot projects when visualizations are used or had been used and
downloaded before.

W orkaround: In case you are running into memory issues please check that visu files which are no longer required
are deleted using the "Files" tab in the editor of the main CPU node (delete the files in 'PlcLogic/visu/").

AB-15729

The "Scan for devices" functionality does not work when the "Log" Editor of the V3 PLC is opened, After the call of
"Scan for devices" it is also no longer possible to add any object in the device tree (as long as the "Log" Editor is
active).

W orkaround: select another editor tab and call "Scan for devices" again

AB-15749

PROFINET and CM589-PNIO: As of 2nd download coupler does not work, 1st DL and bootproject are ok.
W orkaround:
Start project as bootproject.

CPUFW-6641

System: IEC task watchdog followed by Online -> Reset warm leads to crash of PLC.
W orkaround:
Open

CPUFW-6142

CM579-ETHCAT: In some configurations, the state of the last EtherCAT slave is shown as red circle in AB device
tree, even if slave works fine.

W orkaround:

Ignore wrong state and/or check state with POU.

CPUFW-6134

Using generated device diagnosis code and IEC60870 in parallel is currently not supported.
If you use IEC60870 please do not activate the feature 'Enable Diagnosis for devices' via ‘PLC Settings’ tab of the
PLC node. Inconsistent code would be generated resulting in compile errors.

AB-15075

Deleting of an AC500 V3 PLC in the tree might fall if there is an invalid AlarmConfiguration task configured. An error
message "Invalid object guid..." might be displayed and the PLC cannot be removed.

Workaround: Delete AlarmManagerT ask below task configurtion and delete then the PLC node.

AB-15554

EtherCAT: Usage of the SyncUnits feature with enabled AutoConfiguration for AC500 V2/V3 EtherCAT might result
in compilation errors as some ENI file data gets not correctly generated.

Workaround: in case you are running into such errors please contact Automation Builder support team

AB-15520

Runtime licensing:

Return license feature of runtime license is working on AC500 firmware versions 3.1.3 and higher. Please update
ACS500 firmware first to this version and then return licenses. Otherwise runtime licensing on this PLC will become
unusable!

Fw 3.1.0

Projects created with AC500 V3 PLCs in Automation Builder 2.0 require to manually exchange the following libraries:
AC500_ExtUtils -> AC500_PM
AC500_IntUtils -> AC500_lo, AC500_PM
AC500_EthernetUtils -> AC500_Ethernet

The V3.1 library "AC500_Ethernet" contains all Function blocks from the V3.0 library "AC500_EthernetUtils"

The V3.1 library "AC500_lo" contains Function blocks from the V3.0 library "AC500_IntUtils"

The V3.1 library "AC500_Pm" contains Function blocks from the V3.0 library "AC500_IntUtils" and "AC500_ExtUtils"

LIB-1424
LIB-1421
LIB-1419

Projects for AC500 V3 PLCs created with Automation Builder 2.0 need manual update if CM modules had been used
as slot numbering is changed now in Automation Builder 2.1. If POUs with a "slot" parameter are used, the slot needs
to be adapted to the physical CM position (from 1 to 6) on the terminal base. If EtherCAT is used in "synchronous
mode", the event tasks need to be changed (e.g. "EventTask1" for the first slot, "EventTask3" for the third slot).

AB-12531

System: PLCShell command "date" and "rtc-set" cannot set a date after 2038
W orkaround:
Open

CPUFW-5870

Ethernet: FTP server: FTP server: If FTP server is configured on booth Ethernet interfaces ETH1 and ETH2, FTP
server will be activated on ETH1 with configuration of ETH1. The FTP server configuration of ETH2 will be ignored.
W orkaround:

Configure FTP server only on one Ethernet interface ETH1 OR ETH2.

CPUFW-5869

Network Variables (NV): does not work with default Broadcast address 255.255.255.255
W orkaround:
Use other Broadcast address as 255.255.255.255, e.g. 192.168.0.0

CPUFW-5803

TLS/SSL self-signed certificates can't have an End-date after 2038.

CPUFW-5765
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W orkaround:
None, Open

Modbus TCP server: fast On/Off switching of server can lead to incomplete log entries (e.g. missing IP address)
Workaround:
None, Open

CPUFW-5763

CAA-File: If the userdisk is full, the PLC won't create the INI file with production data on the SD card.
Workaround:

- Don't fill userdisk to 100% (pr